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How To Use This Booklet
This booklet is filled with a variety of teaching tips to assist you, the 

instructor, with improving your course and helping your students 

get the most out of their course experience. Review the entire 

booklet or use the index on the next page to skip to the topics that 

are of most interest to you.

Here are some things to keep in mind:

•	 Some tips may work better for your course than others. 

•	 You may need to try some tips for a while to determine if they 

are working. 

•	 Begin by selecting a few quick and easy to implement tips then 

move on to tips that take more planning. 

•	 By gradually implementing these tips you limit the feeling of 

being overwhelmed by the changes and get to see incremental 

improvement in your course and students.

If you are unsure of which tips will help improve your course, 

the Office of Teaching and Learning offers personalized and 

departmental coaching. Our instructional coaches can help you 

review your course and design a plan that is manageable and 

specific to your course. 

Sincerely,

Dr. Stacy Duffield

Director  |  NDSU Office of Teaching & Learning
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TIPS

2024 

EDITION!

These tips are taken from breakout sessions at the 2024 
Faculty & Staff Academic Conference. References and 
citations for data or statistics listed here can be found in 
the videos that will be posted on our YouTube channel at 
www.youtube.com/c/ndsuotl.

Research & Creative Activity Services: From 
Proposal Development to Intellectual 
Property
1.	 To reach the right person to answer your questions, 

get to know RCA staff and the services each 
unit provides. These emails can also be used for 
questions. Ndsu.researchdev@ndsu.edu, ndsu.
businessdev@ndsu.edu, ndsu.research@ndsu.edu.  
Find a staff contact list at 				  
https://www.ndsu.edu/research/about_rca/contact/

2.	 Learn the acronyms - The Research Development 
(RD) office is for pre-pre-award support, Sponsored 
Projects Administration (SPA) office is for pre-
awards, Innovation & Economic Development office 
is for industry relations, NDSU Research Foundation 
(NDSURF) is for intellectual property access and 
Strategic Research Initiatives (SRI) is for large, multi-
disciplinary efforts or federal relations.

3.	 Sign up for an Orcid ID which is your personal 
“Digital Persistent Identifier.” It will seamlessly 
amalgamate your publications when needed for 
NSF, NIH Biosketches. https://orcid.org/signin

4.	 Sign up and get to know ScieNCv – a new, required 
formatting for sponsored project Biosketches and 
Current and Pending Support documents 		
https://www.ncbi.nlm.nih.gov/sciencv/

5.	 Novelution is NDSU’s proposal development & 
tracking software. Your proposals must be routed 
and signed off through Novelution https://www.
ndsu.edu/research/for_researchers/novelution/

6.	 RCA publishes a newsletter twice per month 
during the academic calendar which contains 
stories about successful researchers, tips and 
tricks for grantwriting, information about Limited 
Submissions, finding funding, and federal regulation 
changes. Read or at least skim the newsletter to see 
what’s new and required. 

Admission Overview & Diverse Student 
Recruitment
1.	 Know how your program/department compares to 

NDSU’s top competitors and be able to highlight 
differentiating factors.

2.	 Be able to share the value of your program/
department with a variety of populations

3.	 Develop experiential activities for recruitment 
events. These hands-on elements give prospective 
students a tangible sense of what studying in your 
program will be like and showcase the practical 

skills they will develop.

Recruiting Graduate Students: Tips For 
Faculty
1.	 Consider the following ideas for finding prospective 

graduate students. 1) Update your program 
website 2) Mention your program when you give 
presentations 3) Host a virtual open house 4) Ask 
for student recommendations from colleagues in 
your field 5) Encourage your own undergraduates 
to apply 6) Recruit at conferences 7) Advertise on 
Google ads or social media.

2.	 Responding to prospective students who are already 
in the “recruitment funnel” is highly effective. 
Admitting students in a timely matter is the most 
effective recruitment tool.

3.	 Be sure your prospective students are able to easily 
find deadlines, admission criteria, and application 
requirements on your program web page and 
in the catalog? A holistic admissions process is 
considered best practice and typically yields more 
underrepresented students.

Human-Driven Generative AI & Authentic 
Assessment Design
1.	 Remember the many limitations of GenAI outputs.
2.	 Review and revise all of the GenAI outputs.
3.	 Use the effective prompting framework, including 

role, task, and requirements to get the best output.



Being a Good Partner to TCUs and Tribal 
Communities: An Indigenous Perspective
1.	 When considering working with TCUs and/or Tribal 

Communities, remember to have early, often, and 
transparent communication with them. Trust takes 
time to build and they, as a stakeholder in your 
proposed partnership, should have an equal voice 
in the proposal design and implementation process. 
Contact them before your “pen hits the paper” and 
write them in as a partner with predefined activities 
and budgets.

2.	 Each TCU and Tribal Community is unique in 
its culture, people, and practices. Each bring a 
different perspective and strength to the table. 
Each community also has different challenges, so 
understanding the needs and strengths by having 
meaningful conversations should be a priority.

3.	 Become familiar with data sovereignty as it applies 
to research within Tribal Communities before 
approaching a conversation about a potential 
partnership. Do your part to educate yourself on the 
diverse cultures, norms, and regulations as it applies 
to what you will be proposing.

Encouraging Academic Honesty In The Age 
of AI
1.	 AI Detectors: Violate FERPA and are proven inaccurate.
2.	 Instructional Design Center & Office of Teaching 

& Learning can help you develop alternative 
assessments.

3.	 Communicate clearly your expectations regarding 
use of generative artificial intelligence, both in the 
syllabus and verbally.

Giving Engaging Presentations
1.	 Prior to giving a presentation, identify your 

intention. What exactly do you want to accomplish 
with this presentation?

2.	 Now identify the actions you will use to accomplish 
your intention. For example, I will (action:) excite 
my audience so they will (intention:) discuss my 
research with their colleagues. 

3.	 Practice your presentation. If you tend to be nervous 
when presenting, practice in front of others. Actors 
spend about one hour practicing for every minute 
they perform in front of an audience. 

Event Planning 101
1.	 It will help you avoid conflicting events if you pick 

your date and time based on the Campus Events 
Planning Calendar.

2.	 Work with Event Services on the details.
3.	 Use myNDSU to promote and market your event. 

CCAST Support For AI-Related Research & 
Teaching
1.	 Discuss AI needs with CCAST. If you plan to make 

use of CCAST HPC resources for AI research and 
education, set up a time to talk with us about your 
needs. If you plan to use CCAST in the classroom, 
let us know your needs a semester in advance so we 
can make sure you have the resources prior to the 
start of your course.

2.	 Participate in CCAST HPC training programs.
HPC skills are essential for conducting AI-
related research at scale. Develop these skills by 
participating in our training programs offered every 
fall, spring, and summer semester. CCAST training 
programs are open to all faculty, staff, & students at 
NDSU, and collaborators at other institutions.

3.	 Contact CCAST Support for help. Adapting 
existing AI workflows to run on HPC clusters can 
be difficult and is a frequent source of frustration 
for AI researchers. CCAST staff have substantial 
experience deploying AI/ML software for HPC, and 
we are here to help. Review our Knowledge Base 
articles and tutorials on AI/ML and email us at ndsu.
ccast.support@ndsu.edu if you’re having trouble 
getting AI codes to run properly.

Best Practices in Course Materials
1.	 The NDSU Bookstore is here to help with all your 

course material needs!
2.	 If digital course materials work well for your course, 

save your students money with NDSU’s Inclusive 
Access program.

3.	 The NDSU Bookstore supports faculty academic 
freedom and affordable course materials for all 
students.

 

Moving Your Technologies/Ideas From Lab 
To Market With I-Corps
1.	 Get Out of the Lab: By going out and talking to 

your potential customers and end users, you will 
gain a stronger understanding of the daily problems 
they experience and how your project could help 
alleviate those issues.

2.	 Keep an Open Mind: You may think you know 
exactly who will use your research, but you will 
be surprised when you go out and interview 
people. By keeping an open mind and listening to 
your interviewees, you can gain a much stronger 
understanding of their needs and areas that your 
research could grow.

3.	 Utilize Your Resources: Recognize the various 
networks and channels you have available to you, 
and put them to good use to find stakeholders to 



talk to. Is there a trade show or conference coming 
up? Attend it and gain some great perspectives from 
others working in your field. 

The Art of Recruitment: Creative Strategies 
For Recruiting Prospective Students
1.	 During recruitment events, offer a broad description 

of the program. Highlight key aspects such as 
curriculum structure, specializations and unique 
features like dual degrees or certifications. This helps 
prospective students understand the full scope of 
what your program offers and how it aligns with 
their career goals.

2.	 Include experiential activities, such as interactive 
workshops, lab demonstrations, or simulation 
exercises, in your recruitment events. These hands-
on elements give prospective students a tangible 
sense of what studying in your program will be 
like and showcase the practical skills they will 
develop. This can be particularly engaging and help 
differentiate your program from others.

3.	 Utilize current students and alumni to participate in 
recruitment efforts. They can share their personal 
experiences, achievements, and insights, making the 
program more relatable and accessible. Featuring 
“cool” students and successful alumni in these events 
or on your digital platforms can inspire prospective 
students and provide real-world examples of the 
program’s impact on career paths and professional 
success.

  
Managing Conflict With Emotional Intelligence
1.	 You have innate emotional intelligence AND you can 

improve it.
2.	 Emotional intelligence focuses on both personal 

competencies and social competencies.
3.	 There are multiple intelligences and they are complex.

Unlocking Success: Maximizing the Power of 
Generationally Diverse Teams
1.	 When collaborating with a generationally diverse 

group, it’s crucial to reflect on your own assumptions 
and biases. Consider how generational stereotypes 
might unconsciously shape the way you interact with 
others. 

2.	 To foster a truly cohesive team, focus on finding 
a shared purpose that everyone can rally around. 
This collective goal will channel the team’s diverse 
passions into effective collaboration. 

3.	 Make it a point to share your expertise openly and be 
equally eager to learn from the expertise of others. 
Remember, everyone brings unique skills and talents 
to the table. By fully embracing and leveraging this 
diversity, your team can achieve more robust and 
innovative outcomes.

Artificial Intelligence in Application
1.	 If you are going to use software, be sure to check for 

FERPA Compliant Software. 
2.	 Although there are many benefits remember that it is 

a suspension of reality. 
3.	 Be creative!

Starting the Difficult Conversation
1.	 When preparing for a difficult conversation, be sure 

to start with you first.
2.	 Take time to prepare or think about what you will say 

during your conversation.
3.	 Create an environment where everyone is talking.

All About The Center For Accessibility and 
Disability Resources (CADR)
1.	 Learn about different processes that The Center 

for Accessibility and Disability Resources supports 
students and staff. 

2.	 Gain knowledge on the framework of Universal 
Design for Learning. 

3.	 Gather some insight on quick and fast ways to create 
an accessible classroom looking through the lens of 
Universal Design for Learning.

Why “Laziness” Might Be A Myth
1.	 The next time you notice you may be frustrated with 

a student, it may be helpful to reflect on if you are 
blaming them as a person or the situation.

2.	 How might you use your knowledge of intrinsic 
motivation to both design your class and better 
understand student behavior?

3.	 The presence of co-creation and shared responsibility 
for learning can be a deeply motivating learning 
environment for students.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started



Notes



TEACHING & 
LEARNING 
CONFERENCE 
TIPS

2024 

EDITION!

These tips are grounded in high-leverage practices you 
can incorporate into your class. These tips are taken from 
the sessions offered in the 2024 Teaching and Learning 
Conference. References and citations for any data or 
statistics listed here can be found in the videos posted on 
our YouTube channel at www.youtube.com/c/ndsuotl.

What Are High-Leverage Practices?
High-leverage practices are research-based and foster 
student engagement and learning; they are broadly 
applicable and usable across disciplines.

Metacognitive Reflection
Provide students with opportunities to plan for their 
learning, monitor their understanding, and evaluate their 
thinking.

Share with students how engaging in metacognitive 
reflection promotes their learning. Repeat frequently!

Introduce students to evidence-based learning 
practices, like retrieval practice, space practice, 
interleaving, elaboration, and concrete examples.

Reflective Practice
Ask students to regularly reflect on their learning 
journey, focusing on what they have learned, how 
they have applied the knowledge, and their personal 
growth. These reflections can be powerful tools for 
both the student and teacher to gauge progress and 
development.
  
Cultivate a Growth Mindset Classroom 
Culture
Create an environment that prioritizes growth, effort, 
and learning over final outcomes and grades.
 
Normalize Challenges and Failures
Teach students that challenges and failures are integral 
parts of the learning process. 

Space Out The Learning
Encourage students to space out their learning and 
avoid cramming. Spacing out learning is more effective 
and efficient in the long run. You can build spacing 
into your courses by delaying homework assignments, 
quizzes, or practice so that students learn about a topic 
in class, and then some time passes (e.g., a few days 
or weeks) before students practice with the content 
through assignments later.

Practice Retrieval
Create opportunities for students to practice retrieval, 
or bring information to mind from their memory. 
Retrieval practice is effective and efficient at promoting 
long-term, durable learning. Give students low- or 
no-stakes practice quizzes, and include questions 
that requires them to think back to older content to 
encourage spaced retrieval practice.

Reduce Test Anxiety
Encourage retrieval practice to reduce test anxiety. 
Research has shown that practicing retrieval can 
actually help decrease test anxiety. Free writing about 
their anxiety related to tests or quizzes can also alleviate 
test anxiety for students.

The Influence of Cognitive Biases
Acknowledge the influence of cognitive biases on 
student learning and decision-making, but also 
recognize your power to navigate them. 

Cultivate a Learning Environment
Cultivate a learning environment that supports 
reflection on reasoning and rationale, especially for 
common misconceptions that influence how students 
apply class concepts to every day life. 

Frame Your Lessons
Frame the main points of your lesson to align with 
students’ currently held mental constructs and 
motivations so they can be more easily learned and 
applied to daily decisions. 



For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

Help Student Understand Their Worth
Help students understand that they are worthy and 
interconnected with each other and the world.
People thrive when they are in good relationships and 
their environments, and understand they have worth 
simply as they are.

Create Just And Equitable Learning 
Environments
Create a just and equitable learning environment: do 
all students in your classroom feel acknowledged and 
accepted for who they are, including their race, gender, 
sexuality, socioeconomic status, religion, language, etc.? 

•	 Create opportunities for everyone to participate 
without barriers.

•	 Endeavor to create a space of belonging for your 
students.

•	 Consider whether your pedagogy and curriculum 
consider diverse approaches and are culturally 
responsive.

Create Lessons For K12 Students
Adding an assignment where college students create 
lessons for K12 students can increase their scientific 
identity, encourage skills not typically assessed in a 
college classroom (like creativity and artistry), and set 
the stage for community and school involvement. 

Make sure to guide the college students in how to 
structure a lesson well by giving them an outline:  
introduction, visual aid, hands-on activity, and 
assessment of the elementary students. 

Facilitate reflection about the activity after it is complete, 
and tell your students why you are providing them with 
this opportunity and what you hope they will gain from 
it.

Student Engagement
Using technology as a teaching tool may result in higher 
levels of student engagement. 

Informally Assess Students
Adopting a class starter creates opportunities to 
informally assess students’ learning and strengthen 
faculty relationships. 

Use Case Studies
Effectively using case studies in the classroom can 
enhance critical thinking and communication skills.

Understand Teacher Development
Teacher development is a process.

Teacher development impacts the implementation of 
high-leverage teaching practices.

Teacher burnout impacts development.
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These tips are grounded in the idea of retention and 
are methods, ideas, and actions you can incorporate 
into your class. These tips are taken from the sessions 
offered in the 2023 Teaching and Learning Conference. 
References and citations for any data or statistics listed 
here can be found in the videos posted on our YouTube 
channel at www.youtube.com/c/ndsuotl.

What is Retention?
Often times the definition for retention focuses on post-
course results as a way to quantify student numbers 
for retention. A shift from that is to a focus on the 
assignments in classes and how students can persist in 
a course. It is about student success in the present and 
how that carries students forward in their degree path 
and careers.

Mentorship
Increase mentorship opportunities. This establishes a 
community of peers and increases student confidence in 
the face of potential failure. This means students are more 
willing to ask questions and fail if they feel supported.

Why is Mentoring Important For Retention?
Three reasons are that it:
1.	 Enhances the overall experience for the student.
2.	 Improves class outcomes & productivity of students.
3.	 Establishes a community and network for students to 

work and thrive in.

Types of Mentoring
Hierarchical/Dyadic: Traditional mentoring from one 
mentor to multiple individuals.

Cyclic: Peer-to-peer mentoring where students work 
with and support each other.

Network: A newer model of mentoring where the student 
has multiple mentors from across different disciplines 
and levels.

*Cyclic and Network mentoring are shown as being more 
beneficial than the traditional model

Empathy
Teacher empathy, specifically, the degree to which you 
work to deeply understand and have care and concern 
for students, can positively impact learning, persistence, 
engagement, self-regulation, & post-graduation 
readiness.

Know Your Students
Getting to know students can help you better understand 
the issues that are prevalent in your classroom. One 
characteristic that is important to know is where students 
come from. Depending on their background, they might 
have issues and hurdles that keep them from succeeding 
and feeling a sense of belonging in the classroom. 
Understanding this and reaching out to students shows 
you care.

Be “That Person” For Students
Having one person that is truly listening and cares for 
a student can be a reason a student persists in their 
program. A student may be going through a hard time 
and associate this with their schooling at the university. 
Let them know those feelings are valid. 

Understand Student Intimidation
Students often are scared to ask questions and feel 
intimidated by you. This may stop them from asking 
an important question that will help them get through 
a problem they are having. Letting students know, 
through empathy, that questions are never trivial and it 
is important to ask them, can help students feel more at 
ease in the classroom.

Cautions For Using Empathy
1.	 Bias: People tend to favor those who are more like 

themselves.
2.	 Stress: It makes empathy more difficult.
3.	 Burnout: Important to maintain a self/other 

distinction when considering other people’s feelings 
and not feeling like you need to be empathetic 100% 
of the time.

4.	 Scope: Know what your scope of practice is. You are 
not a counselor, so make sure students know where 
to go on campus.

5.	 Power: Understand there is a lot of power between 
you and a student. Knowing student backgrounds is 
important but asking students to represent a whole 
cultural group may put too much pressure and create 
uncomfortable scenarios. 

Accessibility 
Accessibility goes beyond buildings and classrooms 
on campus with automatic doors and ramps to allow 
physical access. Students have different needs that can 
make it harder to achieve; they may  have visual, auditory, 
or physical impairments that may hinder them from 
completing or working on an assignment, participating 
in a group, or actively listening during class.



Allow Students to Have a Part
Rather than you trying to build a static plan, students can 
be given a choice that lets them have an active part in 
moving their education forward. Using this method of 
instruction will not only help students achieve success 
and persist in their studies, it can also get them more 
involved and increase the quality of work they see as 
being more of their own design.

Remove Barriers
Learners come from different backgrounds and 
experiences that affect the way they learn. You may not 
see some of those barriers at the beginning of a course. 
An example of removing a barrier is, allowing a student 
who cannot type their essay to dictate it via Word or 
record their voice for the instructor to listen to. While this 
can be more work, it can also refresh a course in that it 
opens up new avenues for assignments to be completed.

The Why of Learning
If your course is not necessarily focused on building 
writing skills, students can be given multiple options for 
an assignment that does not have to be a typical essay 
or traditional research paper. Videos, magazine layouts, 
and podcasts are just some ways that assignments can 
engage in different ways and at different levels that still 
meet the why of an assignment.

The What of Learning
In what way is the information presented and accessed? 
Giving students options that go beyond traditional 
reading, like videos or PowerPoints with subtitles will 
allow students, who would otherwise not be able to 
engage with content, to be an active part in the class.

The How of Learning
Creating ways students can express themselves in their 
own unique way encourages students to be active with 
their coursework and feel attached to what they are 
being asked to do.

Guide to Accessibility
1.	 Make small manageable changes to your course 

and assignments. Start out with one assignment you 
tweak to slowly change your course and adapt it to 
the current cohort of students in your class.

2.	 Create and provide opportunities for feedback from 
students. This will help you identify issues and barriers 
in a class your students are grappling with. 

3.	 Create opportunities to overcome and break down 
issues and barriers. This way, students can get to their 
learning and progress forward in a class and help you 
move forward in the class curriculum. 

Community
Make connections to campus, programs, instructors 
and fellow students. It is important to help students feel 
like they are a part of a community. This was especially 
relevant during the COVID-19 pandemic. Friends 
can make this connection which can last through an 
undergraduate experience. You can make lasting impacts 
that keep students rooted on their career path at NDSU. 

How to Build Community 
Small things to help students feel at home at NDSU are 
to:

1.	 Call out student names and actively engage them in 
the classroom.

2.	 Have in-depth conversations with students as an 
advisor which makes them feel appreciated and 
taken care of.

3.	 Make it known that students can meet with you 
outside of class which gives students the confidence 
to seek help and make them feel appreciated in their 
college community when they are struggling.

4.	 Offer an introduction which can show students a 
side of you students would not otherwise see. This 
shows them an instructor trusts them and wants to 
welcome them into the NDSU community. 

Co-Create Class Expectations
Allow students the opportunity to understand and add 
to what the expectations of a class are. This gives them 
responsibility and helps them understand what their role 
as a student is and what the teacher’s role is.

Connect Before Content
Allow students time to engage with one another before 
engaging with content. This builds a sense of community 
and helps them understand where they might want 
to go with their career as they share knowledge and 
experiences with fellow students.



Set the Tone
What do you want the class to feel like? Students should 
feel engaged and excited if that is what you want for the 
tone of your classroom. Bring in activities for students to 
do, which is a great way to set this tone.

1.	 Check in Question:  Welcome students and build the 
classroom community by asking a casual question at 
the beginning of class. This is a great way to engage 
students right away and to get to know them better. 
E.g. What’s your favorite book? If you could remove 
one stressor from your life, what would it be?

2.	 Storytelling and Humor: Add these into a lecture or 
lesson to help students feel appreciated and engaged 
because it shows them you are human and want to 
get to know students. Getting too serious about a 
topic can serve as a disconnect with students. Not 
being afraid to laugh and share experiences is key to 
developing a community that works toward the goal 
of learning and growing. E.g. Connect a lecture with 
your past experience that has a funny element

3.	 Get Creative: Mix things up by being creative in 
the classroom. E.g. Self-care day: snacks, pajamas, 
blankets, etc.; Competition: Jeopardy, Family Feud, 
Board Games, Door Prizes; Setting: go outside, walk 
the halls; Materials: Use Crayons, Play-Doh, rocks.

 

Belonging
Opening a lecture with a big smile and projecting 
empathy awakens students and makes them feel alive 
and a part of a community that cares.

E.g. Ask yourself questions like “Do students feel as 
though they belong?”, “What is my part in that sense of 
belonging?”, and “What intentions and actions are being 
reflected in my classroom?” These all give you  a place to 
start when thinking about retention and how you can be 
an active part of influencing students in a positive way.
 

Showcase Optimism and Excitement
Hindering the building of community is the fact that 
some students feel and even know that some professors 
do not want to be in their classroom and that they would 
much rather be spending their time working on other 
things such as research. This makes it hard for students 
to feel that important connection to campus, especially 
when professors are blatant about how much they do 
not like teaching or dealing with undergraduates.

Be Honest About Courses
Generally, students do not understand what it really 
takes to teach a class at the undergraduate level. Being 
open with students without revealing too many personal 
or work-related details will key students in on just what 
it takes and will make them more sympathetic to your 
struggles and will encourage students to respect your 
time. This means if students know you cannot see them 
this week, they have an opportunity to plan ahead and be 
understanding of your busy schedule. 

Course Materials 
Make an easy to follow schedule and syllabus that are 
linked together with assignments makes the transition 
into the NDSU community easier since it gives them 
a clear structure to follow that guides them in a new 
environment that might seem daunting. Reassuring 
students with clear and concise materials like these 
opens up students by giving them a clear idea of what 
their place is in your classroom environment.

Checking in  
Whether a class is online or in person, it is important to 
check in with students with reminders about upcoming 
important dates and assignments. Showing students you 
are thinking about them and the class increases a sense 
of belonging since it shows students you are putting 
effort in to making sure students are taken care of. 

Student Careers
Laying out job prospects and opportunities for students 
in different programs is a great way to reassure students 
of the choices that they have made when considering 
their career after NDSU. Students will develop trust 
and respect for you if they feel that you have their best 
interests in mind.

Global Detail vs. Specific Detail
When you describe things in general to students and do 
not overwhelm them with minute details, students will 
get a good idea of what a program has to offer them. 
If they have further questions and are interested in a 
program, that is where you can step in and answer them.

Highlight Students and Alumni
Potential students want to see themselves in a program. 
Help them see this by highlighting successful students. 
This will attract students to a program that interests them 
and is a good fit for what they want out of a program.



For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

Get NDSU Students Involved
NDSU students can share their experiences and passion 
for their program as a way to get prospective students 
talking and interested in NDSU programs. When NDSU 
students share details about their program in a way 
their advisor or instructor allows, this shows trust and 
responsibility, it also reaffirms the student’s place at 
NDSU as a member of our community.

Miscellaneuos Teaching Tips
Here are some tips every instructor should keep in mind!

Hybrid/Hyflex Courses
These courses can contribute to retention by providing 
students with flexible learning options and a personalized 
learning experience. There is more upfront preparation 
work for you for both of these options, but the pay off in 
time  saved from not having to catch students up is more 
than worth it. If students know they can access recorded 
lectures online they will not have to try and piece together 
what happened from readings and notes. Students who 
seek to gain the most out of courses like these are ones 
who may have other commitments or responsibilities 
that take them away from their coursework and being 
able to attend in-person at a regularly scheduled time.

Examples of students who need or would benefit from 
these courses are students who are parents, are sick, 
work full-time, have health issues or disabilities, lost a 
family member or are having a family emergency.

Ungrading 
When students focus on learning rather than solely 
the grades they retain information and get more value 
out of course content. This is especially true when 
considering that at the college level, their grade is their 
own responsibility. This means if there is an opportunity 
to guide from the sidelines and be solely a resource 
and mentor, those opportunities should be taken to 
encourage students to work and achieve through their 
own volition. Keeping this in mind, you should strive to 
provide extensive feedback to students.

Make Courses More Affordable  
If you are able, give students open and free resources  
online via NDSU licenses, this can be a great way to avoid 
students having to buy textbooks. This ensures students 
who can not afford a textbook stay in class, since the 
materials and resources are free and easily accessible.

Alternative Assessments
Traditional assessments may not accurately reflect the 
full range of knowledge and skills students bring to a 
course. That is where alternative assessments can step in.
 
1.	 Offer multiple attempts on tests. If the goal is for 

students to learn, giving the opportunity to correct 
mistakes will facilitate that learning. 

2.	 Reflect on work. By allowing students to reflect on 
their work and the progress of the course, students 
can go back and conceptualize their learning by 
ordering it and better understanding it as they seek 
to recall skills and knowledge learning. 

3.	 Declaration quizzes add another way to give students 
an alternative path via assessment. These quizzes 
give students responsibility and trust by having 
them answer on a quiz whether they completed 
certain tasks. If they did then they are responsible for 
knowing that content. 

Reasons to Look at the Syllabus
Give students a reason to look at the syllabus. Offer an 
assignment where students look for typos or a scavenger 
hunt. Students become familiar with content you  want 
them to be familiar with.

Use Teams
Teams can be used in the following ways:
1.	 Establish community in a virtual environment where 

students who are spread throughout campus can 
talk to each other quick and easy. 

2.	 Access a Resource Hub where resources can be 
posted for students to use whenever they need them.

3.	 Post workshop and webinar opportunities for 
students to access.

4.	 Provide networking and job opportunities for 
students so they can talk to professionals in the field 
and at the collegiate level. 

5.	 Investigate engagement data so these different 
benefits of Teams can be understood and adapted to 
better suit students and faculty.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
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The following tips you can incorporate into your class are 
taken from the sessions offered in the 2022 Teaching and 
Learning Conference. References and citations for any 
data or statistics listed here can be found in the videos 
posted on our YouTube channel at www.youtube.com/c/
ndsuotl.

Videos in Classes
1.	 The four types of videos you can use in your course 

are: microvideos, tutorials, lectures, and screencasts. 
2.	 Adding video to a course increases engagement and 

is 83% more effective for retaining information.
3.	 Pre-recorded videos allows students to rewatch or 

prewatch videos to learn in their own way and time.
4.	 Offering videos reduces cognitive overload for your 

students.

Mental Models or Systems Models
5.	 Mental models or systems models are the top 

student-ranked most helpful technique or strategy, 
even when the instructor isn’t using it in their class.

6.	 Mental models help you evaluate the starting points 
of your students. If students can work backwards, 
forwards, and in all directions within a concept, then 
they have deep understanding.

7.	 Mental models work best over time and in groups. It 
is cognitively demanding to work alone.

Alternative Grading
8.	 Equitable grading strategies include: optional 

retakes, which can be split out by topic; flexible 
deadlines; limited grading of behaviors; equitable 
grading scales; and ungraded formative assessments.

9.	 Use homework and class time as opportunities for 
learning and feedback. Learning happens through 
mistakes.

10.	 Grades promote risk aversion and encourage 
performance over mastery. Grading everything 
equates to constant judging.

Adult Learners
11.	 In adult learning you are the facilitator who helps 

students navigate their learning.
12.	 You can promote independent learning in your 

class by slowly removing supports throughout the 
semester.

13.	 Connect adult student’s learning with life experiences.
14.	 Adult learners tend to learn more from their peers.
15.	 Practice the See, Do & Teach method with adult 

learners because they learn better when they have 
to teach someone else a concept.

Language Diversity
16.	 Recognize there is language diversity in every class; 

it may be through different languages, different 
regional or cultural dialects, or even familial usage 
of the language.

17.	 If personal interactions are pleasant, people are more 
willing to take on the cognitive load of listening to 
an individual with an accent. Facilitate pleasant 
interactions with your students.

18.	 Students have a higher cognitive load when they are 
worried about grammar. Consider not grading based 
on language and grammar usage when the concepts 
are the most important thing to learn (ex. discussion 
boards).

19.	 Grammar is the first thing to breakdown when 
learning new concepts.

20.	Be specific about grammar expectations in your 
assignment rubrics.

Helping Students Write Better
21.	 Provide students with many examples of good 

writing in your field.
22.	 Instruct students on the writing process, which 

is: planning, drafting, sharing, evaluating, revising, 
editing, and publishing. Many students do not know 
the process.

23.	 Hold group discussions to give good quality feedback 
and to discuss their struggles.

24.	 Peer editing helps students analyze both good work 
and their own work.

Student Wellness
25.	 On your syllabus include on-campus resources 

for wellness and a statement of wellness. Assign 
wellness-related tasks like writing a paper on their 
wellness plan or touring a wellness resource.

26.	 In class, use clickers to allow students to anonymously 
gauge how they are feeling today.

27.	 Be a wellness role model for your students.
28.	Offer flexible homework submissions (ex. videos, 

creative writing, etc.), adjust your deadlines to 
promote better sleep for your students, and 
consider offering extra credit or make-up points for 
participating in wellness activities.

Racial Achievement Gap
29.	 If you can adjust a student’s mindset you can help 

them have better outcomes.
30.	Racial achievement gap was two times higher in 

classes with instructors who have fixed mindsets.
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31.	 Instructors with a growth mindset tend to include 
why a student is learning a concept in their class.

32.	 Cognitive resources are split when a student is actively 
trying to avoid being stereotyped, which lowers their 
performance.

33.	 Active learning strategies have a disparately positive 
result for students of color.

Learning By Doing
34.	 Students need to see that you aren’t perfect, and you 

deal with the same issues they do.
35.	 Give students many examples of why they need the 

skills you are teaching them.
36.	 Bring in concepts that fit with the data they are 

working with.
37.	 Teach your students to self teach. Google is your best 

friend.

High & Low Technology for Rapid Feedback
38.	Some high-tech tools that are fast and provide quick 

formative assessments include: clickers, Google 
products, diagrams.net, free polling software, Zoom 
chat, and Zoom polls.

39.	 A useful, low-tech tool for formative assessment is 
a color-coded card that corresponds to the answer 
choices. Students then raise their cards with their 
answer.

40.	Don’t be afraid to improvise in your class.
41.	 Share the polls with your students and why you are 

doing them.
42.	Let your students know it is okay to say, “I don’t know.”

Supporting Students in a Pandemic of Grief
43.	Allow students space to share their story or speak 

about grief in class. Consider using a Blob Tree image 
to facilitate discussion.

44.	Behaviors students might exhibit in class might reflect 
the stages of grief; be aware of the stages of grief.

45.	Sometimes what we see as disengagement from our 
students is actually a grief response.

46.	When a student is going through something big, 
they may tend to be more forgetful, have difficulty 
concentrating, and difficulty making decisions 
because our brains can only process so much.

47.	 Validate your student’s losses.

Use of Video In Your Course
48.	You can use video to: encourage effective learning 

strategies, provide personal and direct feedback, and 
foster a sense of community.

49.	Ask your students to connect a concept to something 
in their life, have them post a video discussing it.

50.	Use video to provide feedback to students so they can 
hear your voice, inflection, tone, and see your non-
verbal cues. It is less formal and faster than written 
feedback.

Trauma Informed Practices (TIP)
51.	 If stress is detected in your learning environment, 

learning will be more difficult for those impacted by 
trauma. If you, as the instructor, project stress your 
students can pick that up.

52.	 Individuals who have endured trauma have a harder 
time switching out of fight or flight mode and back 
into a more productive way of thinking.

53.	 Some of these everyday learning experiences can 
activate a trauma response: lack of choice, team 
building, unclear rules, ambiguity, and forced sharing. 

54.	 Conduct a trauma walk through on your classes. 
There are formal assessment tools available to help 
with this.

55.	 Assess your teaching through these six key principles: 
safety; trustworthiness and transparency; peer 
support; collaboration and mutuality; empowerment, 
voice, and choice; and recognizing cultural, historical, 
and gender issues.

56.	 You might see the following responses in a student 
impacted by trauma who is currently in a fight or 
flight mode: difficulty focusing, attending, retaining, 
or recalling information; absenteeism; fear of risks; 
trouble with emotional regulation; anxiety about 
deadlines or coursework; withdrawl or isolation; 
unhealthy relationships; or nothing at all. Trauma 
informed practices is based in equity, meaning you 
customize the tools for the individual’s strengths. 
Don’t assume that a person has had a trauma, but 
know it is a possibility.
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The following tips, you can incorporate into your class,  
are taken from the sessions offered in the 2021 Teaching 
and Learning Conference. References and citations for 
any data or statistics listed here can be found in the 
videos posted on our YouTube channel at www.youtube.
com/c/ndsuotl.

Teach With Empathy (Not Sympathy)
Sympathy is not empathy. Sympathy is a feeling of pity and 
sorrow for someone else’s misfortune. Empathy is a way 
of connecting with people that shows you understand 
they are experiencing something meaningful- even 
though you may not understand exactly how it feels 
for them. Instructors high in teacher empathy do not 
lower standards; they identify and remove obstacles to 
learning.

Get To Know Your Students
In order to make an impact on students’ lives you need 
to understand them first. You can do this by deploying 
a student survey. You can ask students to write a “This 
I believe…” essay. You could also ask students to create 
their reflexivity statement.

Adopt A Growth Mindset
Help students adopt a growth mindset. This is the belief 
that I will need to persevere through difficulty before I 
succeed. The desire to work hard consistently with the 
courage to ask questions when confused.

Inclusive Course Policies
Design course policies that reflect a deep understanding 
of students’ personal and social situations – Incorporate 
course policies for greater inclusion and equity. Inclusive 
and equitable teaching provides opportunities for 
success for students from ALL identities. 

Build Trust With Your Students
Trust your students, assume they are trying their best. 
Recognize each student has different pressures on 
their time and energy. Help your students understand 
the learning goals. Tell them the “why” behind each 
assessment.

Collaborate With Students
Let students lead the learning process by collaborating 
with students to discuss progress on meeting their 
learning goals. Invite students to set personal learning 
goals within the domains of the course. Enable students 
to complete self evaluations and reflections across the 
semester. You might also reconsider strict deadlines.

Ease Asynchronous Learning
For asynchronous learning, make it easy for students 
to access materials – make it obvious where to start, 
mention clear, attainable goals and objectives. Mention 
the standard methods of submitting assignments.

Create An Organized Course
Create streamlined content for students to follow. 
An organized course is the key to student success. An 
unorganized course will cause delay in assignments 
being completed. Make Blackboard navigation easier. 
Allow for students to have easy, accessible, and organized 
materials on Blackboard.

Be Flexible With Your Students
Flexibility improves the learning experience of your 
students. Post notes, assignments, class materials at least 
5-7 days before deadlines. Provide structure by having 
assignment deadlines but have a flexible deadline policy. 
Allowing students to resubmit assignments or retake 
tests increases their motivation to learn.

Create An Engaging Learning Environment
Using a variety of ways to display and provide 
information is optimal for desired learning outcomes. 
Offering opportunities for choice and autonomy is one 
way you can create a more meaningful and engaging 
learning environment. Often students do not understand 
or appreciate the reason why what they are learning is 
important. Establishing the “why” behind what you teach 
will help your students see relevance and value in the 
material.

Use Creative Ways To Engage Students
Instructors can use creative ways to engage students. 
For example, Dr. Sylvio May presents finger puppets 
alongside his presentations about the specific scientist 
being discussed. Dr. Beena Ajmera created themed weeks 
for students to create backgrounds on Zoom to fit into 
the themes. Dr. Jenny Linker shared how she used Swivel 
software in the classes she holds in the gymnasium. The 
camera follows the professor and can be integrated into 
Zoom.

For more information or assistance, contact:
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LITTLE HINTS 
To Use With Your 

STUDENTS
Advising Edition

Providing little hints throughout the semester can help 
your students succeed. Use the content on this printable 
to provide a new tip for your students each week during 
your regular class session. Some tips have suggestions 
for you in parenthesis. You may use this list as written 
or you may pick and choose which tips to use based on 
your specific class demographics.

Week 1
Ensure your class registration is final, inquire about wait 
lists if needed, and introduce yourself to your academic 
advisor.

Week 2
Identify the office hours on your syllabi for each class 
and keep the list handy for when you need them!

Week 3
Find a good study space on campus that works for 
you. Spaces include your residence hall/apartment, the 
library, and outside some classrooms. There are a lot of 
great spaces around campus!

Week 4
Check on your current grade and attendance for each 
class. If you missed assignments or quizzes can you make 
them up? What else can you do to get back on track?

Week 5
Have you sent or received any emails from your advisor 
yet? If not, now is a great time to have an initial meeting 
to start to discuss your interests in the major.

Week 6
Learn about academic organizations to get involved with 
for your major. (Highlight a few that are relevant to your 
department or program.)

Week 7
Browse your major department’s webpage – view faculty 
bios and learn about their research interests. Can you 
get involved with their research or other opportunities? 
(Share a few minutes about something you are working 
on and how undergrads have been or could get involved.)

Week 8
Midterm of the semester – check in with faculty members 
again and prepare for midterms. Look ahead for any big 
final projects.

Week 9
Take a look at your Degree Map and familiarize yourself 
with the academic requirements for your major. You can 
plan a tentative list of classes to discuss with your advisor. 
(https://ndsudm.civitaslearning.com/)

Week 10
Think about Spring registration and meet with your 
academic advisor.

Week 11
Take note of your current grade in the class and remaining 
work. Do you need to consider a withdraw from the 
course? Discuss options with your instructor and advisor. 
(Put a note on the syllabus/weekly tip that you are willing 
and open to chat. Students may need the reminder it’s 
okay to visit.)

Week 12
Check your Campus Connection account for any holds 
that may prevent timely registration for next semester. 
(https://www.ndsu.edu/onestop/holds)

Week 13
Register for classes as close to your assigned registration 
time for best availability of classes and class times. 
(https://www.ndsu.edu/onestop/registration)

Week 14
Put together a study plan for final exams.

Week 15
Make use of any study sessions offered. (List study 
sessions for your class.)

Week 16
Reflect on how the semester went and what adjustments 
you might want to make.

Inspired by an NDSU OTL We Learn Together Blog post titled, Being 
First, in which a student named Hajira greatly benefitted from the little 
hints her instructor gave.
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CREATING
ACCESSIBLE
DOCUMENTS
Email - Microsoft Outlook

Use this list to check for common accessibility issues in 
Emails. This document specifically addresses Microsoft 
Outlook as that is the campus-supported software. 
Microsoft offers step-by-step instructions on how to fix 
accessibility issues, and further explanation on why these 
are important. Use this quick tips sheet to meet the basic 
accessibility requirements.

Include Alt Text With All Visuals
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text helps people who can’t see the screen to 
understand what’s important in images and other visuals. 

	» How: Control + Click the image or object > Edit alt 
text > Type 1-2 sentences in the text box to describe 
the object and its context.

Do Not Use Infographics in Place of Text 
Why: Screen readers cannot read images or infographics 
without alt text. Unless your image has alt text, do not send a 
.jpg or PDF as the only item in an email. Another option would 
be to add the text in the image or infographic as text in your 
email.

Add Meaningful Hyperlink Text
Why: People who use screen readers sometimes scan a list of 
links. Links should convey clear and accurate information about 
the destination. For example, instead of linking to the text Click 
here, include the full title of the destination page. 

	» How: Click on the insert link option on the bottom toolbar 
> Insert Link > Write the information about the destination 
in the description > Write the URL in the web address box

Don’t Use Color To Convey Information
Why: People who are blind, have low vision, or are 
colorblind might miss out on the meaning conveyed by 
particular colors.

	» How: Add an underline to color-coded hyperlink 
text so people who are colorblind know the text is 
linked even if they can’t see the color. For headings, 
consider adding bold or using a larger font.

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If you use black or gray text in your 
emails, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background. If 
you struggle to read the email, so will your readers.

Add Table Header And Column Information
Why: To keep track of their location in a table, screen 
readers count table cells and use header information 
to identify rows and columns. If a table is nested within 
another table or if a cell is merged or split, the screen 
reader loses count and can’t provide useful information 
about the table. Blank cells in a table could also mislead 
someone using a screen reader into thinking that there is 
nothing more in the table.

Use A Larger Font Size
Why: People who have dyslexia describe seeing text 
“swim together” on a page (the compressing of one line 
of text into the line below). They often see text merge 
or distort. To reduce their reading load use a larger font 
size, 11pt or larger.

	» How: Click on the font size bar > Select a font size of 
11pt or larger

Include Sufficient White Space
Why: In order to reduce workload for individuals with 
dyslexia, make sure there is ample white space between 
sentences and paragraphs

Request Accessible Emails
Why: If you wish to make sure you receive accessible 
emails, you can let the sender know that you prefer to 
receive accessible content.

	» How: Click the settings icon on your Outlook on the 
web > In the search bar type “Accessible Content” > 
Click on Accessible Content > Select the “Ask senders 
to send content that’s accessible” checkbox > Click 
save

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
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CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft Word

Use this list to check for common accessibility issues 
in Microsoft Word documents. Microsoft offers in-
depth information on the use of its accessibility checker 
feature as well as step-by-step instructions on how to fix 
accessibility issues, and further explanation on why these 
are important.

Insert Document Titles
Why: Document titles provide information on what a 
screen reader is reading.

	» How: File menu > Properties > Summary > Title > 
Enter descriptive title for your document.

Use Alt Text For All Images
Why: Screen readers cannot read photos without alt text 
or descriptions. Individuals may miss or wonder if they 
have missed important information.

	» How: Click image > Picture Format menu > Format 
Pane > Layout & Properties ( ) > Alt text > Simple 
images, fill in title, Ex: John Doe; Images with words 
or diagrams, fill in title and description box with 
information explaining image significance or what 
text in the image says.

Use Table Headers
Why: Table headers explain the information in columns 
a screen reader reads. Without table headers, a screen 
reader reads, “Accessibility issues, 10, 14, 3” versus “Book 
title accessibility issues, Page 10, Total pages 14, Number 
of follow up questions 3.” 

	» How: Insert menu > Table > Choose columns & rows 
+ 1 extra row > Table Design menu > Ensure Header 
Row box is checked > Type column headers in first 
row of table

Use Headings And Sub-Headings
Why: Provides a logical reading order for screen readers. 
Saves time with accessibility when exporting to a PDF.

	» How: References menu > Add Text > Highlight text to 
classify as heading or sub-heading > Choose Level 1, 
then Level 2, then Level 3 as needed. 

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

	» How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or 
email option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use 70% tint for your gray/black colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

	» How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 
25%” or a lesser percentage. “Lighter 25%” means the 
tint is 75%. If you use anything more than 25% lighter, 
your document will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

	» How: You can use color to differentiate but offer 
another differentiation tool. This could be numbers, 
letters, or other characters.

Watch For Extra Spaces After Words
Why: Extra spaces after words or sentences are read by a 
screen reader as either “space” or “blank.” Neither convey 
meaning and can contribute to confusion.

	» How: Make an effort to NOT add spaces after 
sentences; and, add, “check for extra spaces,” to 
your editing process. Place cursor at the end of each 
paragraph, use the right arrow key to see if there are 
extra spaces, and delete any you find. 

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
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CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft PowerPoint

Use this list to check for common accessibility issues in 
Microsoft Powerpoint presentations. Microsoft offers in-
depth information on the use of its accessibility checker 
feature as well as step-by-step instructions on how to fix 
accessibility issues, and further explanation on why these 
are important.

Use Unique Slide Titles
Why: Individuals using a screen reader skim through 
slide titles to navigate; they quickly scan slide titles and 
go right to the slide they want. Using unique slide titles 
allows them to clearly understand which slide they are on. 
Avoid using the same title for slides that have spill-over 
information, consider including additional information 
such as ‘Slide Title 1 of 2’.

Use Built-in Slide Templates
Why: Built-in slide layout templates are designed so the 
reading order is the same for people with vision and for 
people who use screen readers. 

	» How: Design menu > Select a built-in slide template.

Add Alt Text To All Images, Objects and Tables
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text provides a textual alternative to non-text 
content.

	» How: Right click the image or object > Format picture/
object > Size & Properties ( ) in the left pane > Alt text > 
fill in title and description explaining the object or image.

Use Table Headers
Why: Table headers explain the information in columns a 
screen reader reads. Without table headers, a screen reader 
would not be able to correctly read the table. 

	» How: Insert menu > Table > Choose columns & rows + 1 
extra row > Table Design menu > Ensure Header Row box is 
checked > Type column headers in first row of table

Set Reading Order Of Slide Contents
Why: Screen readers read the elements in the order they 
were added to the slide, which might be different from the 
order in which things appear. It’s important to check the 
reading order by using the Selection Pane. The reading 
order in the Selection Pane should be arranged from the 
bottom up. The title should be at the very bottom with 
subsequent content above it.

	» How: Home > Arrange > Selection Pane > Arrange the 
reading order by dragging the objects on the right pane.

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

	» How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or email 
option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

	» How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 25%” 
or a lesser percentage. “Lighter 25%” means the tint is 75%. 
If you use anything more than 25% lighter, your document 
will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

	» How: You can use color to differentiate but offer another 
differentiation tool. This could be numbers, letters, or 
other characters.

Avoid Excess Animation
Why: People can get vertigo or be sensitive to moving 
or flashing images. Because of this, animation should be 
kept to a minimum. Strobing or rapidly moving images 
should be avoided, as this can make certain viewers sick 
or cause a seizure.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials



CREATING 
ACCESSIBLE
DOCUMENTS
PDFs

Use this list to make sure the final PDF document is 
accessible when converting documents into a PDF 
file. The first and most important thing is to ensure the 
document you are converting follows all accessibiity 
standards. Once you have made sure there are no 
accessibility issues, follow these steps. The most common 
adjustments will be discussed below.

Save A Document As PDF
Why:. In order to preserve the accessibility changes made in 
the PowerPoint or Word document, the PDF conversion has to 
be done in a specific way.

	» How(For Mac): Click file > Save As > Select PDF from the 
file format dropdown > In Microsoft word check the box 
labeled “Best for electronic distribution and accessibility” 
> Save.

	» How(For Windows): Click file > Save As > Select PDF 
from the file format dropdown > Options > In Microsoft 
word check the box labeled “Document structure tags for 
accessibility” > Ok > Click save.

Use The Accessibility Checker Feature
Why: The Accessibility Checker feature will automatically check 
to see if there are any accessibility errors. If you have used the 
accessibility checker features in other platforms, you will have 
minimal adjustments to make in a PDF. 

	» How:  Click Tools > Accessibility > Accessibility Checker > 
Start checking > The system will automatically check for 
accessibility issues and show if there are any issues. To 
resolve issues simply Right Click on the unresolved issue 
> Click Fix.

Add A Title To The Document
Why: Having a document title makes it easier for someone using 
a screen reader to know what document they are listening to. If 
you missed this, you can still do this during the PDF accessibility 
check.

	» How: Click Document > Title > Control + Click > Fix > 
Uncheck “Leave as is” and change document title.

Set The Appropriate Reading Language
Why: An appropriate language must be selected in the PDF 
properties so that the screen reader knows what language to 
read in. 

	» How: Click File > Properties > Advanced > Reading 
Options > Select “English” or the appropriate language the 
document is written in. 

Make Sure The Document Uses High Contrast
Why: Make sure that the document is in high contrast so 
that the text is easier to read for sighted and low sighted 
individuals. This means dark text on a light background or 
light text on a dark background.

	» How(For Mac): Open File in Adobe Acrobat DC > Click 
Acrobat Pro DC > Preferences > Select Accessibility > 
Check the “Replace Document Colors” box > Select “Use 
High-Contrast Colors“ > From the dropdown list select 
“black text on white”.

	» How(For Windows): Open File in Adobe Acrobat DC > 
Click Edit > Preferences > Select Accessibility > Check 
the “Replace Document Colors” box > Select “Use High-
Contrast Colors“ > From the dropdown list select “black 
text on white”.

Set The Reading Order
Why: Since the reading order is unique to each document, 
the accessibility checker is unable to fully check the reading 
order. Double check that the PDF is reading the document in 
the intended order. 

	» How: Click Tools > Accessibility > Accessibility Checker 
> Reading Order > Show Order Panel > Review the 
numerical order for each page. For items a screen reader 
would not read, click + ctrl or right click on the number of 
the item in the side panel. From the menu, choose what 
type of content it is. “Tag as Decorative/Background” will 
indicate that it is not content that adds meaning to the 
document.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials



LITTLE 
HINTS FOR 
INSTRUCTORS

Get off to a great start and keep the momentum going 
with these helpful hints for your classes this semester.

 Week 1
TIP 1: Check on your books and materials in the NDSU 
Bookstore to ensure the books are in and there are 
adequate numbers for your course enrollment. 
TIP 2: Provide a tour for your students in Blackboard 
to show them how you will use it and where to find 
important items. You can do this during a class session, 
record a video and post it in Blackboard, or provide a 
written guide.

   Week 2
Administer a survey to get to know your students better 
and support their learning. A survey template is available 
in the Qualtrics NDSU Library. See sample items. 
(https://drive.google.com/file/d/1RmqzI9yZWTOz2mMqzwiE4K31LL-kcwrm/view)

   Week 3
Help your students get to know one another by using 
group activities to learn the content and allotting the 
first minute or two for introductions and sharing. 

   Week 4
Your students will learn better and are more likely to 
retain the information when they can experience the 
content by seeing, hearing, saying, and writing. We often 
only plan for the seeing and hearing. Include activities 
during class that allow students to write and speak about 
the content.

   Week 5
Learn more about the Student Course Experience 
Surveys your students will be asked to complete at the 
end of the semester. 
(https://www.ndsu.edu/gdc/qualtrics/student_rating_of_instruction_srois/)

   Week 6
Spring semester course materials orders are due 
November 1st. The NDSU Bookstore is required by law 
to list all course materials for all NDSU courses.

   Week 7
Prepare and administer a midterm feedback questionnaire 
in your classes. A survey template is available in the 
Qualtrics NDSU Library. It can be as simple as this.
(https://drive.google.com/file/d/1EYWHdHSzNE9PTvXbnxo19swOD3Yud69d/view)

   Week 8
Share the midterm feedback and how you will address 
any concerns with your students so they know you are 
listening.

   Week 9
Students will learn more when they receive narrative 
feedback that tells them what they are doing well and 
how they can improve.

   Week 10
Want help building your final assessment? Consultants 
in the Office of Teaching and Learning can help, whether 
it’s a traditional exam or a performance assessment. 

   Week 11
Keep notes about what is going well with your class and 
what you want to change for next time. We think we will 
remember, but when it gets busy, it’s easy to forget. 

   Week 12
Have you kept your grade center up to date?  If not, now’s 
a good time to catch up and communicate with students 
to let them know where they are at in the class. 

   Week 13
Sign up for Peer Teaching Partnership for the next 
semester. Select either the formal or informal track. 
Learn more.  	 (www.ndsu.edu/otl/programs/peer_teaching)

   Week 14
Set your students up for success by holding office hours 
for additional study time for the final exam or, if students 
are completing projects, workshop time to consult with 
you and receive feedback. 

   Week 15
Avoid getting numerous emails from students by posting 
the timeline for posting grades for the final assessment 
and course. 

   Week 16
Even though it’s tempting to disconnect immediately 
after finishing up the class, take a few minutes to revise 
your syllabus for next time while everything is still fresh 
in your mind.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started



PERFORMANCE 
OBJECTIVES 
What should the students be able to do?

What are instructional objectives? 
Also often referred to as learning objectives and 
performance objectives.

	» Instructional objectives are specific, measurable, 
short-term, observable student behaviors. 

	» An objective is a description of a performance 
you want learners to be able to exhibit before you 
consider them competent.

	» An objective describes an intended result of 
instruction, rather than the process of instruction 
itself.

Writing objectives for using Bloom’s 
Taxonomy and associated action or 
performance verbs.

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

Parts of a performance objective:    
Answer the question: “What should the students be able 
to do?”

Objective:  The students will be able to infer the 
developmental needs of a child by documenting evidence 
aligned with developmental theory.

The students 
will be 
able to

determine the 
development 
needs of a child

by documenting 
evidence 
aligned with 
developmental 
theory.

Audience:
Standard 
introduction 
for an 
objective.

Hint:  Focus on 
the students, not 
the teacher.

Behavior/Action 
Verb that is 
measurable and can 
be assessed.  What is 
the learner to do?

Content- description 
of the subject matter 
to be learned.

Hint:  Must specify 
observable and 
measurable behaviors.

Condition to 
be met by the 
students in order 
to demonstrate 
that the objective 
has been 
achieved.

Hint:  Describes the 
circumstances, situation 
or setting.

Sample Performance Objectives:
	» The students will be able to draw inferences about 
the causes of WWII.

	» The students will be able to identify the verbs in 
sentences.

	» The students will be able to explain the purpose of a 
given text.

	» The students will be able to apply the principles of 
design to a poster.

	» The students will be able to categorize rocks by type.
	» The students will be able to describe the habitats of 
various animals.

	» The students will be able to predict the outcome of 
habitat changes.

	» The students will be able to accurately measure wet 
and dry ingredients.

	» The students will be able to select the correct plant 
types to be grown in a particular environment.

The following are NOT observable or measurable 
performance objectives:

	» Appreciate the beauty of a circuit 
	» Understand relativity theory 
	» Be familiar with the law 
	» Understand the process of osmosis 
	» Enjoy speaking French
	» Learn about erosion
	» Listen to the lecture

Adapted from resources found at:
www.bu.edu/cme/forms/RSS_forms/tips_for_writing_objectives.pdf
https://tips.uark.edu/using-blooms-taxonomy/

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



WRITING 
COURSE 
OBJECTIVES

What are course objectives?
Course objectives directly state what the students 
will know or be able to do by the end of the course. 
They ensure the instructor and students have a clear 
path through the course. All learning experiences and 
assessments should align to the course objectives.

Course objectives are:
	» Specific
	» Concise
	» Student-centered
	» Measurable
	» Student-friendly
	» Aligned with program objectives/goals

What does a course objective look like?
Example

The students will determine the developmental needs 
of children across all domains.

	» Student-centered—it states specifically what that 
students will be able to do.

	» It includes a measurable action verb
	» It identifies the content aligned with program goals.
	» Student friendly—it isn’t overly technical, and is 
easily understood by students.

A program goal/outcome from which this course 
objective is derived may look like:

	» Students will understand developmental domains.

How are course objectives different from 
individual session objectives?
The learning objectives for an individual course session 
are at a more granular level than an overall course 
objective and lead the student toward the corresponding 
course objective.

For example:
Course Objective— The students will determine the 
developmental needs of children across all domains.

	» Session Objective—The students will recall the 
developmental domains. (knowledge)

	» Session Objective—The students will list the 
common characteristics of the stages of cognitive 
development. (knowledge)

	» Session Objective—The students will recognize 
developmental delays. (evaluate)

	» Session Objective—The students will create a therapy 
plan for a child with developmental delays. (synthesis)

Note: the action verb guides assessment. For example, 
knowledge-level learning can be measured through 
limited-response quizzes or tests; while higher level 
learning can be measured with constructed response 
and projects.

Bloom’s Taxonomy
Although there are several taxonomies for learning, 
Bloom’s is the most widely known and used. Bloom’s 
Taxonomy serves as a useful resource for identifying 
the action verb needed for writing effective objectives. 
The following chart provides the six learning levels and 
examples of aligned performance verbs.

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



TIPS FOR 
FILMING 
VIDEOS

Whether you are filming a lecture for your class or a 
video for YouTube, there are some strategies you can use 
to ensure your video is of good quality. A video of good 
quality makes it easier for the viewer to receive your 
message. 

Here are a few tips to ensure your video is of good quality.

Plan your video in advance
Planning your video in advance provides numerous 
advantages in terms of quality. The most important 
reason is that it decreases the amount of time spent 
filming and editing your video.  

Follow a script
Write a script before recording, the script entails what 
you will talk about in the video. The video needs to be 
short, concise and to the point. So, write your script 
keeping that in mind. 

Use good lighting
Preferably record In a shady area that will give a softer 
light. Avoid overhead lighting because that will cause 
harsh shadows on the subject’s face. 

Use a clean background
An easy way to do this is to have a solid-colored 
background like a blank wall. If you do not have or do 
not want to use a clean background, be sure to check 
that background elements in the camera frame are 
representative of the message you want to send and are 
not distracting.

Film with minimal background noise
Depending on the microphone sensitivity, lots of times 
microphones will record random noises like a fan, traffic, 
or background conversations. Record in a place free 
from those background noises. 

Have good audio recording device
Borrow a microphone if needed and connect it to 
the camera. The Office of Teaching and Learning has 
microphones available to borrow.

Avoid shaky footage
It is not possible to have the camera handheld and 
not have shaky footage. It is best to use a tripod or set 
up a camera on a flat surface so your footage looks 
professional. The Office of Teaching and Learning has a 
tripod available to borrow. 

Record with the best quality
Minimum quality should be 1080 pixels (px) at 30 frames 
per second (fps). Check your camera or phone to ensure 
it is recording at these settings. If you are using a phone 
to record be sure you have it set up horizontally rather 
than vertically. 

Appear natural in front of the camera
Try to appear as natural as possible. Use open body 
language. Maintain good posture. Keep your shoulders 
relaxed. Avoid crossing your arms since this makes you 
look closed-off. 

Speak slower
Individuals have a tendency to speak faster when they 
are on camera or in front of a crowd. Before you begin 
speaking pause and remind yourself to speak slower and 
enunciate tricky words. 

Make sure to smile
A smile, especially at the beginning of the video, offers a 
sense of warmth and appears welcoming.

Look at the lens
Be sure to look at the lens of your camera or the general 
direction of the camera on your computer this is how your 
eyes will connect with your viewers eyes. If recording 
from your computer, it may help to tape a photo of a 
person near the lens. 

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



GETTING OFF
TO A
GOOD START
Helping All Learners Feel Welcome

The learning environment sets the stage for learning. 
Here are a few ways to set up your learning environment 
to make your learners feel welcome and able to learn.

Comfortable Seating
Think of comfort broadly.
	» The seating should establish opportunities for 

students to see and be seen and feel like they belong 
in the classroom. 

	» Can the seating be arranged in a circle to all allow 
learners to see one another?

	» Another option is to arrange the seating around a 
table or put desks in pods to encourage discussion 
and collaboration.

	» Can you position yourself as the instructor in ways 
that allow you to be close to your learners, make eye 
contact, and see and hear them when you are talking 
and eliciting their ideas?

Look and Feel of the Room 
Unlike our K-12 educator colleagues, higher education 
instructors typically don’t have their own classroom 
that can be customized to have a warm or personalized 
look and feel. However, there are things we can do to 
personalize the space we use. 

For example:
	» You can project an image and/or message that 

students see when they enter the room.
	» You can add a message to the whiteboard, welcoming 

students and/or giving them something to think 
about related to the day’s learning.

	» Another idea is to create learner toolkits that can 
be housed in the classroom or brought with you to 
class that include items that support thinking and 
discussion such as a mini-whiteboard, discussion 
prompts, response cards (Yes, No, Need More 
Information), activity protocols, resource sheets like 
a conversion chart or glossary, etc. 

	» Finally, consider creating a personal introduction 
for your students and inviting them to do the same. 
For example, post a photo and brief welcome that 
includes a glimpse into your interests and hobbies.

Communication

Although Zoom and Teams meetings have made us more 
aware of the expressions on our faces and how the way 
we look may be perceived, educators are often under-
aware of their non-verbal communication and tone. Plan 
for intentionality.
	» Position yourself near your students and work the 

room, so you aren’t only interacting with the students 
in your “splash zone.”

	» Practice holding a warm, interested, and friendly 
expression on your face. 

	» Make eye contact with your students to show them 
you are listening and paying attention to them.

	» Don’t be afraid to make a mistake or admit you do not 
know something. Instead, share with the students 
how you corrected the mistake or how you will learn 
what you don’t know.

	» Finally, review your syllabus for messaging; perhaps 
even invite a colleague to review it, letting you 
know the tone they feel. Can you set high and 
clear expectations while maintaining a warm and 
approachable tone?

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



GETTING OFF
TO A
GOOD START
Engaging Learners

Engagement is predictive of several positive academic 
and life outcomes including academic achievement, 
reduced drop-out rates, greater satisfaction with life, 
and a better overall sense of well-being. In fact, without 
opportunities for students to connect with learning in 
meaningful ways, they don’t learn. So, how can you make 
engagement more likely? 

Engagement by design is an intentional approach to 
planning built upon the principle that every student 
deserves a learning experience with high levels of 
engagement. 

Classroom Relationships  
Relationships are among students and the content, 
peers, and instructor. Students are more likely to form 
a relationship with content when they can see how it is 
relevant, interesting, and useful. Positive relationships 
with peers that support engagement and learning require 
time and structure. Structure includes establishing 
guidelines for interaction that include respectful speaking 
and listening and worthwhile activities. Roger and David 
Johnson are experts in the field of cooperative learning 
with excellent resources on structuring collaborative 
interactions. Trust is the foundation of forming a 
relationship with your students. Trust is fostered when 
students see you as competent, which includes both 
knowing what you’re talking about and delivering on 
your promises. Students also trust instructors more 
who provide the instruction and feedback they need to 
succeed. In addition, relationships can be fostered with 
your students through sharing appropriate but personal 
information such as a photo and brief welcome that 
includes a glimpse into your interests and hobbies and 
inviting them to do the same.

Learner Voice
This includes listening, learning, and leading. Learners 
need to be taught how to listen to one another and 
provided with the structure for listening that includes 
expectations and modeling of respect and active listening.  
After hearing the ideas and perspectives of others, 
learners should be given the opportunity to demonstrate 
that they heard and learned from that experience. Finally, 
learners need opportunities in class to take responsibility 
for their own and others’ learning—not just passively 
intake content from the educator.

Student Value

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

Students need to feel like they belong along with being 
recognized, appreciated, and celebrated. Value is 
cultivated when student growth and accomplishment is 
recognized. Value is also furthered when a student knows 
others believe in them. Keep in mind that recognition can 
be private such as sincere and performance-anchored 
feedback on an assessment. Belief can be conveyed with 
statements that not only tell the student you believe in 
their abilities but also explain how you know this (e.g., “I 
know you can do this. You have the knowledge and skills 
needed to complete this project. Let’s review what you 
know…”)

Clear and Worthy Content
Thoughtfully examine the content included in your class.  
Is it all important? Can you provide a strong rationale if 
asked “Why do we need to know this?” Once the worthy 
content is established, determine how you will clearly 
inform learners what they are expected to learn and what 
the success criteria look like.

Challenging Learning Experiences
Learners need an opportunity to rise to the challenge of 
learning the worthy content. Identify complex questions 
and problems for learners to grapple with. Help learners 
see the relevance in the content and the connections 
across the discipline.

1. Fisher, D., Frey, N., Quaglia, R. J., Smith, D., & Lande, L. L. (2018). Engagement by design: 
Creating learning environments where students thrive. Corwin.



QUALTRICS
Managing Your Account

Qualtrics is a robust survey software available to all 
faculty, staff, and students. When you take full advantage 
of its features your survey creation is more efficient. 
This section offers a variety of tips for using Qualtrics 
efficiently. Here are some tips for managing your 
Qualtrics account. 

Register For Your FREE Account
All NDSU faculty, staff, and students have access to a 
FREE university sponsored Qualtrics account. 

Claim your account here:
https://ndstate.qualtrics.com

Change Your Time Zone
Be sure you have your Qualtrics account set to the 
correct time zone. NDSU is on Central Time. 

To set the time zone:
	» Find “My Account” on the right side with your initial.
	» Then find “Account settings.” 
	» Look for Time Zones. The default is Mountain Time.
	» Change this to the time zone you are in or Central 
Time for the time zone NDSU is in.

Customize Home Page
Customizing your home page allows you to quickly get 
to what you use most often. 

To customize your home page:
	» Click the gear icon under Welcome to XM.
	» You can turn on or off the Active Surveys and Your 
workflows summary.

Manage Notifications
	» Click the bell icon on the top right.
	» Click the three dots.
	» Notification Settings is where you can turn on 
or off Notification Channels (Email and Mobile 
Notifications), Notification Types (Collaboration, 
Recommendations, Surveys, and Workflows).

Delete Notifications
To delete notifications on your home screen that you are 
done with do the following. 

	» Hover over a notification you don’t need anymore.
	» You will see the three dots. 
	» Select “Remove notification.”

 

Create Folders to Organize Projects 
You can create folders to organize all of your survey 
projects and allow you to access them quickly.

To make folders:
	» Locate “+Create new folder” on the bottom left. 
	» Give the folder a name (folders show in alphabetical 
order). You can create folders within folders.

	» Drag and drop surveys into the appropriate folders.

Search all surveys by highlighting the Project and 
Programs folder or search within individual folders.

Identify The Owner Of Your Surveys
If you have surveys that are shared with you, you may 
need to know who the owner of each survey is. To find 
this out, go to the Projects Page. While you are on that 
page you will notice a gear on the right. Click the gear 
and there is Owner option check box. By checking that 
box a column will appear with the name of the owner of 
each survey listed.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.gdc@ndsu.edu
www.ndsu.edu/gdc



QUALTRICS
The Basics

Here are some tips for ensuring your Qualtrics basic 
survey information is set-up correctly and accessible. 

Use Next & Submit Buttons 
The next and submit buttons are important for navigating 
through your survey and are also used for accessibility 
purposes. The default arrows are not descriptive and 
are difficult to navigate when using a screen reader. In 
addition, adding a “Submit” button allows survey takers 
to know that the survey is ending and the is their last 
chance to edit responses, if they choose. 

How to change the buttons to read next & submit:
	» Highlight a block by clicking on the whole block. 
	» Look to the left for “Format.” 
	» Then look for “Next/previous buttons” when you 
click the button a Next/Previous Button text box will 
pop up. 

	» In the text box, type “Next” (or “Submit” if this is the 
only block with no page breaks). Remember the 
block with the “Submit” button must not contain any 
page breaks. 

	» Go to each section of the survey and repeat the steps.

This section also allows you to set the text for a “Back” 
button, if you choose to allow survey takers to change 
their responses in a previous section. 

Use Survey Display Names
Screen readers need survey titles and display names 
in order for the survey to be clear to the survey taker. 
The default survey name is “Online Survey Software  |  
Qualtrics Survey Solutions,” which is not descriptive of 
your survey. 

To add the survey display name:  
	» Open your survey. 
	» Look for the survey options icon.  (Hint: if you need 
labels for the menu icons, click > at the bottom of the 
screen to enable them.) 

	» In the “General” tab, look for “Display name”. 
	» Enter the survey title in the text box.

You may also choose to edit the survey description while 
you are there.

Setting Your Survey Availability
You can choose to set the timeframe in which your 
survey is available for individuals to take it. To do this, 
start by opening your survey.  

	» Navigate to “Survey options” and “Responses“ tab. 
	» Scroll down to “Survey availability” and click “Set 
specific start and expiration date.” 

	» Click “Edit Survey Availability” 
	» Set the Start date and Start time.
	» Set the Expiration date and Expiration time. If you 
want the survey to end at midnight, set it to 11:59 
p.m. to ensure that it is accurate. 

The survey will not be available until the start date and 
time have passed in the time zone your account is set to. 

Copying and Pasting
To achieve a consistent look in your survey when you are 
copying and pasting text you will want to ensure the fonts 
are all the same and at the same size. This is easiest to do 
as you go rather than waiting until you have completed 
the entire survey. 

To do this:
	» Look for the “Rich Content Editor” in blue above the 
text box you are pasting the information into this 
gives you formatting options.

	» The “Remove Formatting” in blue removes all 
formatting for only that question. 

The strip formatting option is also available in the survey’s 
tools, but it applies to the entire survey, so if you use it, 
you will need to redo any special formatting in the survey.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.gdc@ndsu.edu
www.ndsu.edu/gdc



QUALTRICS
Advanced Survey Set Up

Here are some tips for intermediate and advanced users. 

Ensure A Survey Is Only Taken Once  
There are times when you may want to ensure individuals 
take your survey only one time. To do this:

	» Open your survey and navigate to survey options.  
	» Look for the “Security” tab. 
	» Turn on “Prevent multiple submissions” option.

In the Qualtrics panel, by default, the survey taker can 
only take your survey once, unless you change the 
settings in the compose email section.

To change the settings:
	» Click “Show Advance Options”
	» Change “Link Type” to “Multiple Completes” or 
“Anonymous.” 

Adding A PDF To A Question
There are times when adding a PDF to a question is useful 
to your survey takers. First, decide if you need a display 
logic or skip logic for the question. Then decide what 
kind of question type you are setting up.

To add the PDF:
	» Click into the question you want to add a PDF to.
	» Click “Rich Content Editor.”
	» Click on “More.” 
	» Click the page icon with the corner turned down. 
	» Upload a New File and choose your PDF file.
	» When you are finished uploading, create a link to the 
PDF by highlighting the link & clicking the chain icon. 

	» Click on the “Target tab” to make sure it is set to 
“New Window (_blank).” This will open the PDF in a 
browser window so you don’t lose the survey taker.

Adding A PDF To A Workflow  
Have the survey open and click “Workflows.“

	» Create a workflow
	» Under “Templates” select “Start a workflow when a 
survey response is received or updated” then click 
“Survey response.” 

	» Name the the workflow.
	» Click on the “+.” This is where you decide if you have 
a condition or not. 

	» Select “Task.”
	» Email
	» The “To” area can be piped from survey questions, 
leave “From” as is, be sure you put something in the 
subject line.  

	» The body of the email is where you will insert the PDF. 
	» Select a library the PDF is in or upload the PDF.

When you are finished there should be a PDF link in the 
body of the email.

Create A Loop & Merge Block 
Loop and merge is based on a question that requires a 
number entered as an answer. The numeric question 
would be on a separate block from the loop and merge. 
For instance, How many pets do you have? loop and 
merge questions would repeat based on the number 
you entered. If you answered 3 pets, it loops back to the 
question, What is your pet’s name?, two additional times.
 
To create a loop and merge:

	» Make your numeric question required.
	» Make another block with the questions you want to 
repeat.

	» Highlight the entire block and look to the left for 
Block behavior, similar to Loop & Merge.

	» Enable Loop & Merge.
	» Select the option “Loop” based on a question and 
select the question in which you want to base Loop 
& Merge on

	» Select Choice and Maximum Loops.
	» You can delete Field 2 if you don’t need more than 
Field 1. 

	» Save
	» You can pipe the Field 1 (Click where you want to put 
the Field 1 and then click on Rich Content Editor) by 
each question in the Loop & Merge. followed by {A} 
icon to pipe find Loop & Merge and Loop & Merge 
Fields. This will indicate which loop the question is 
on.

Have A Survey Redirect To Another Survey
If you are doing a drawing or collecting personal data 
after a survey, this is a good setup to keep everything 
anonymous.

	» On the first survey you will click the bottom Block 
that says “End of Survey.” 

	» To the left you will see “Messaging” and a drop down 
list.

	» Click “Redirect to URL.”
	» Paste a second survey link in the “Website URL” box.
	» Publish the first survey.

Recode The Values Of Choices
The default for the first choice in Qualtrics is 1. However, 
if you begin with a positive scale, you will want that value 
to be the highest. To do this:

	» Make sure the question is checked.
	» On the left select “Question behavior” & “Recode 
values.” 

	» Renumber the choices.



Create a Survey Key 
Survey keys are created to ensure questions are correctly 
coded. You also need to send this to the statistics 
department or anyone else who is assisting you with 
survey analysis. The document will show you blocks, skip 
logics, and display logics. The values are in parenthesis.

	» Keep your survey open.
	» Look for “Tools” menu.
	» Select “Import/export” and “Export survey.” 
	» Select “Export survey to Word.” Accept all defaults. 
	» Click “Export.”

Auto-Renumber Your Survey 
Once you’ve finished editing your survey you can auto-
renumber your questions. Here’s how:

	» Have your survey open. 
	» Look for the “Tools” menu. 
	» Select “Auto-number questions.”
	» Select “Sequential Numbering.”

Set Up A Pre And Post Survey 
With a pre and post survey you can compare the data 
without asking the respondent for a code, which means 
you must use the same Qualtrics panel/contacts.

Start with your pre survey and go to the survey flow: 
	» Click “Add a New Element Here.” 
	» Click “Embedded Data.”
	» Pick from the “Survey Metadata” drop down and 
scroll until you find “Recipient ID.” 

	» Add a New Field. 
	» Type “ID” in the first box and “Value” will be piped. 
Click on the down arrow to find “Insert Piped Text“ 
and look for “Embedded Data Field.” Type in the box 
RecipientID and click Insert.

	» Move the “Set Embedded Data” block to the top so it 
is the first thing in the survey flow. 

	» Apply the changes.
	» Repeat the steps for the post survey.

When it comes to “Distributions,” you must use the same 
Qualtrics Distributions email and panel for both surveys. 
If you check the “Anonymize responses” box, the survey 
remains anonymous, but you will see the ID in a column 
where you can compare the data.

Produce Survey Printouts
To produce a survey printout that accurately reflects 
what respondents view, do the following:

	» Have the survey open.
	» Look for “Tools” menu.
	» Select “Import/Export.” 
	» Select “Print Survey.”

Anonymize Responses  
The anonymize responses option doesn’t record the 
survey taker’s IP address, location data, or contact 
information. Once you turn on the Anonymize responses 
option, your respondents’ identifying information is 
hidden. If this setting is turned on before a response is 
recorded, that response’s identifying information is not 
retrievable. If this setting was turned on after a response 
was recorded, the response’s identifying information will 
be retrievable.
   
If you send the link through Qualtrics email you can still 
see who has responded to your survey by looking at the 
“Distributions email history” which is under the drop-
down arrow of your invite.

To turn on anonymize responses:
	» Have your survey open.
	» Go to “survey options.” 
	» Select the “Security tab.”
	» Scroll to the bottom. 
	» Turn on Anonymize responses.

How To Find More Help Documents
NDSU offers a wealth of help documents for the Qualtrics 
survey software. Here are several ways to get additional 
assistance:

	» Search the ITS Knowledge Base using “Qualtrics” as a 
search term. You will bring up dozens of articles with 
answers to common NDSU usage questions. Access 
the knowledge base at >> https://kb.ndsu.edu/

	» View the OTL YouTube channel for tutorial videos on 
Qualtrics features. Visit the YouTube channel at >> 
https://www.youtube.com/c/ndsuotl

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.gdc@ndsu.edu
www.ndsu.edu/gdc



RETENTION
Ideas for Retaining Students

Ensuring students stay, move through a program of 
study, and receive their degree is the cornerstone of 
higher education. You, the instructor, play a pivotal role 
in student retention. What follows is a list of ways you 
can help retain students which was taken from our Idea 
Exchange session on Retention.

1.	 Tell students what you are grading and when they 
can expect their grades. 

2.	 Give assignments back before you grade the next 
assignment so students can use your feedback to 
improve on the next assignment.

3.	 Offer a one-minute paper on what students learned, 
what stood out, what didn’t make any sense, what 
questions do they still have. Then start the next class 
with that information. Student Course Experience 
survey results go up as a result.

4.	 Students are overwhelmed when coming into a large 
lecture. Find ways to connect with those students 
and build community to build a sense of cohesion 
and belonging. 

5.	 Make your students feel safe so they can focus on 
learning.

6.	 As a way for you to learn names, have students 
introduce themselves using a video. They can also 
watch each other’s videos to build community.

7.	 Students don’t often know what office hours are. 
Offer class points for coming to office hours. This 
is an opportunity to engage in conversation and 
connect one-on-one in a large class. It also makes 
students feel more comfortable in attending future 
office hours.

8.	 Call your office hours, student hours or drop-in help 
hours so it is very clear to students what that means.

9.	 For office hours, sit in a less intimidating location like 
the coffeeshop in the union or some other location 
so students feel comfortable coming to visit.

10.	 If allowed, bring your favorite pet to your office to 
draw students to your office hours and lower their 
stress level.

11.	 Break down the norms of your campus or class. 
Don’t assume students know these norms. (e.g. what 
credits are, that there is a new semester with new 
classes, etc.)

12.	Have students name why they are interested in going 
into the field they are and one thing they want you to 
know about them. Address this when they are settled 
in, around week three. 

13.	 Students don’t know what they don’t know. 
14.	 Tell students about resources that are available to 

them, then take them on a field trip to some of the 
key resources, so they know where to go. This instills 
confidence in seeking assistance.

15.	 Ask your students to tell something interesting about 
themselves and then ask about their interest.

16.	Become more than just an instructor to your students 

by showing them something about yourself. (e.g. a 
photo of your pet)

17.	 Do an about me assignment that is not related to 
the content. Ask students to tell you more about 
themself. For example, have them tell you a fun fact, 
a boring fact, and a pet peeve. This will help you get 
to know your students more.

18.	Have individuals in the workforce come speak with 
your students to keep them motivated to get to their 
career.

19.	 Remind students to take one step at a time to get 
through their degree program. They don’t need to 
know everything about their degree, they will be 
introduced to the items they need as they get to 
them. 

20.	Help students work through a decision to switch 
majors. Make it okay to change because students 
often don’t know what a degree means in terms of 
a career at the time they choose a major. Help them 
understand the breadth of jobs available in their 
program.

21.	 Focus on students in a program minor because some 
of those skills are applicable across careers.

22.	Think about how the things that frustrate you as 
an instructor would impact your students. Remind 
students to be patient in those frustrating situations. 
Also, try to identify ways to minimize those frustrations 
for your students.

23.	Offer clear expectations for the assignments in your 
class. Create a rubric so that students know what to 
do. Clear expectations helps avoid frustrations.

24.	Identify and work to fix hurdles for students in their 
specific program.

25.	Recognize there is a level of growth that happens 
when a student first gets to campus.

26.	Help students develop resiliency so they are able to 
deal with challenges when they come up.

27.	 The first few weeks of school are most important 
for ensuring students know the resources available 
& how to access them. This can contribute to their 
sense of belonging & their ability to work through 
any discomfort the student experience may present 
for them.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



NEURODIVERSITY
Ideas for Serving & Retaining 
Neurodiverse Students

Neurodiversity consists of individuals whose brain 
processes information differently than a typical brain 
would. Individuals may have development delays, be on 
the autism spectrum, have adhd, have dyslexia, are gifted, 
or have a number of other diagnosis. Many of the tips 
here focus on autism but these tips are good for most 
neurodiverse students. This collection of tips for working 
with neurodiverse students in taken from the sessions 
offered in our neurodiversity faculty development series.

1.	 Ask and remember whether a student prefers person 
first language (e.g. student with autism) or identity 
first language (e.g. autistic student) and how they 
prefer to be addressed. 

2.  In 2023, 1 in 36 children at age 8 have an autism 
diagnosis, compared to 1 in 150 in 2002. This means 
that a significant number of students coming to 
college in the future will be neurodiverse.

3.	 The autistic brain processes information at a 
conscious level, whereas a typical brain processes 
about 80 percent of information at the subconscious 
level. This conscious processing of information can 
lead to the sensory overload you might see.

4. 	 Students with autism struggle with being 
overwhelmed, time management, organization, 
multi-tasking, task initiation, follow through, 
managing deadlines, and handing in assignments. 
Design your course with this in mind.

5. 	 Neurodiverse students may also struggle with 
presentations, group work, and writing. Assist 
students when and where it is appropriate in your 
class.

6. 	 Disclosing to your students if you are neurodiverse 
may help them feel more understood. But do this 
only if you are comfortable with that disclosure.

7. 	 Examine your course and see if you are ready for a 
neurodiverse student population. If not, make some 
of the following small adjustments that are good for 
all learners.

8.	 Offer a very clear syllabus and if dates need to be 
moved around, update your syllabus and repost 
it rather than telling your students to modify their 
syllabus. Doing so offers clarity on dates and 
deadlines.

9.	 Offer interim deadlines so that students will know 
when they should have specific items completed. For 
example, first draft is due by, final draft is due by...

10.	 Meet individually with a student as needed. Provide a 
short overview of what you will be meeting about. Sit 
side by side facing the same direction as them. Use a 
whiteboard to post instructions that they can take a 
photo of. Speak slower when providing instructions 
to allow for slower processing speeds. 

11.	 Provide progress reports so that students know how 
they are doing in a class if there have been no grades 
posted.

12.	 Allow students to step out of class to take breaks as 
needed. 

13.	 Allow students to bring sensory objects that help 
them focus or stay calm in class.

14.	 If students struggle with social anxiety, offer them 
alternatives to presentations (as appropriate). For 
example, allow them to videotape or present in 
a webinar format. Or even have them present to a 
smaller group.

15.	 If students struggle with group work, which can 
present in many ways, consider selecting groups and 
dividing tasks ahead of time. Neurodiverse students 
may struggle with those type of tasks. Assign a TA or 
GA to monitor group dynamics and ensure no one is 
being bullied or being a bully. Or, allow students to 
work alone if they prefer that and it doesn’t affect the 
intended learning.

16.	 Behaviors in class may look like a student challenging 
you in front of the class, students pacing at the back 
of the room, students leaving class to take a break, 
sensory issues (too loud, too bright, etc.), students 
dominating the conversation, or meltdowns. You can 
alleviate these behaviors by offering clear concrete, 
classroom expectations, having a designated note 
taker for when students need a break, offer civility 
points for discussions, and help students know when 
they are getting off topic. If there are meltdowns 
you should speak calmly and quietly to them, offer 
a quiet space for them to recover, don’t argue with 
them, don’t touch them, and if necessary contact a 
point person/parent or guardian.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



GEN Z STUDENTS
Ideas for Serving & Retaining Gen Z 
Students

Generation Z consists of individuals who were born 
between 2001 and 2010. Many of these students are 
in college now or will be entering college soon. This 
collection of tips is for understanding and working with 
Generation Z students. Tips are taken from the sessions 
offered in our Gen Z faculty development series.

1.	 Gen Z students are considered the first generation to 
have never known a world without technology. It is 
said they “were born with a device in their hand.”

2.	 They seek personalized, value-added education 
experiences, are socially conscious and focus their 
education on their career and future.

3.	 They want to know the “why” of what they are 
learning.

4.	 They are visual, tech saavy, gamers, social, demanding, 
goal directed, and self-reliant.

5.	 Students are not willing to spend time attending 
class if lectures are passive and they can get the 
information later. For example, if your lectures are 
made available online they may choose to skip class 
and watch the lecture on their own time.

6.	 Getting them to attend class may be as simple as 
providing an engaging reason why they should know 
the content you are teaching. Find a way to let them 
dive in to the content and problem solve.

7.	 Rethink the way you teach them. Our speaker called 
this “the meddler in the middle” instead of the “guide 
on the side.” 

8.	 How can you maximize the contact time you have 
with students?

9.	 For each learning objective stop and ask how would 
my students best learn this, then design a classroom 
activity around the “why.” 

10.	Make the content personally relevant and meaningful 
by presenting tough questions or case studies that 
students connect with and will connect them with 
the learning objectives. This fuels a desire to do 
further research and reading. Encourage them to use 
their devices in class to support their research on the 
topic. AI software can help design case studies or 
thought provoking questions. 

11.	 Help your students be engaged in discussion by 
forming a classroom community. 

12.	 Let students know how the case studies or information 
presented will help them in their future careers or 
their personal life. 

13.	 Ask students to bring examples of the concept you 
are teaching, this allows you to see that they are 
connecting the concepts with their world. 

14.	 When asking students to reflect on their learning, 
allow them to pick how they will achieve that. 

15.	 Allow your students to use their technology to 
research on the fly as part of discussions in your class.

16.	You do not have to use any specific technology, they 
are familiar and comfortable learning using almost 
any type of technology. 

17.	 Students are motivated to attend class for many of 
the reasons listed here, but also if they  receive points 
for attending. 

18.	Regarding group projects, students want groups 
assigned at the beginning of class so they sit with the 
same people to form a small community they trust 
which makes doing group work easier. Successful 
group projects are ones that require brainstorming 
or sharing of ideas to complete the task rather than 
writing reports or doing presentations. They want 
to be able to offer feedback on the group work so 
students do not receive the same grade for not doing 
any of the work. 

19.	 Consider how much reading you are asking a student 
to do and be aware they may have multiple courses 
asking them to do them same. If you assign readings, 
make them meaningful so students will prioritize the 
reading for your class. Many students have to choose 
which readings they will finish. 

20.	Bring in someone who currently works in the field to 
help connect the learning, but also to see how they 
structure their work. 

21.	Organized classes tend to relieve stress & anxiety 
most. Be sure your course has built in reminders and 
suggested dates for completion of work, especially 
if it is a 100-200-level class. Or offer a group project 
that teaches them how to create their own schedule 
for project completion.  

22.	Students reflected on what helped them learn most. 
Quiz retakes, one-to-one discussions, application of 
the content learned, and  personal check-ins if they 
are not doing well in the class were strategies that 
helped them most. 

23.	Gen Z students want you to know that they are not 
lazy, they are just extremely efficient in their use of 
technology. 

24.	Show grace to your students during busy times, 
especially if you ask for grace during your own busy 
times. 

25.	If students do not see the value in an assignment 
they may not do it. Give an opportunity to improve 
on their work if they hand it in on time. Also, do not 
take away so many points for late work that student 
no longer see the value in turning int the assignment. 

26.	Let students know what they can come to talk to you 
about at office hours or via Zoom meeting sessions.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



STUDENT MENTAL 
HEALTH
How To Help Students

Mental health diagnoses are more common than you 
might realize. As an instructor you might find yourself in a 
situation where you need to assist a student with finding 
resources for a mental health condition or helping a 
student who is in crisis. Knowing where to find help and 
how to assist a student in need is an important part of 
retaining students. The following are tips from NDSU’s 
Counseling Center and from a panel discussion with 
counselors.

1.	 Become familiar with NDSU’s FREE resources for 
helping students. Counseling sessions are FREE and 
have an unlimited number of visits for students. 

2.	 For genuine concerns about the mental health of 
students or concerning statements in assignments, 
do not hesitate to reach out to the Counseling Center 
for a consultation on how to handle the situation. 

3.	 Mental health conditions disrupt a person’s ability 
to work, carry out daily activities, and engage in 
satisfying relationships. Its symptoms can be just as 
debilitating as the symptoms of a physical disability.

4.	 The most common mental health conditions are 
anxiety, depression, and substance use disorder. 

5.	 Remember how to help a student by using the 
acronym ALGEE. 

6.	 A - Assess for risk of suicide. Ask the individual 
directly, “Are you having thoughts about suicide?” 
or “Are you thinking about killing yourself?” If they 
answer yes ask, “Have you decided how you are going 
to kill yourself?” You will almost always get an honest 
answer. If there is an answer of yes to either of these 
questions you will need to help them seek assistance. 
Do not leave someone alone who has answered yes 
to either of these questions. Get the student to the 
Counseling Center or call FirstLink. 

7.	 Do not use use guilt to try to stop them or agree to 
keep their plan a secret. 

8.	 Have the individual assist in seeking help. Who do 
they want to call to take them to the hospital? Where 
would they like to go? This allows them to feel more 
involved with the process and their treatment. 

9.	 Self injury, in any form, is a coping mechanism to deal 
with the distress or pain they are feeling. If you notice 
a student who has been through a traumatic event 
encourage them to tell others what they need, seek 
help, and use positive coping strategies that have 
worked for them before.

10.	L - Listen non-judgementally. Show that your 
concern is genuine, have empathy, and show 
acceptance. Be attentive to their needs and make 
them as comfortable as possible. This may mean 
sitting down, adjusting eye contact, or having open 
body language.

11.	G - Give reassurance and information. Treat 
the person with respect. Show them you care by 
periodically checking in with them but don’t get 
overly involved or try to solve their problems. 

12.	E - Encourage appropriate professional help. 
Suggest they contact a primary care doctor, 
psychiatrist, counselor or psychologist. Remember 
NDSU’s Counseling Center offers FREE support. 

13.	E - Encourage self help and support from others. 
Self help can include caring for oneself through 
exercise, nutrition, meditation, support groups, self-
help books, and friends or family. 

14.	 Watch for these signs: fatigue, sleeping too much 
or too little, eating issues, unexplained pains, crying, 
isolation, slow movements, etc. 

15.	 Think of depression as worries about the past and 
anxiety as worries about the future. 

16.	Depression contributes to students not returning to 
college in future semesters or years. 

17.	 Know that panic attacks feel real to the person having 
them but they are not life threatening. The individual 
may have a pounding heart and start sweating.

18.	 If you believe a student is having a panic attack in 
your class, you can: Express concern for the student 
and ask if they know what is happening - if they have 
had a panic attack before they will usually know what 
it is. Look for a medic alert bracelet that lists other 
conditions the student may have. Err on the side of 
a medical emergency if the student does not know 
what is happening and call for medical assistance. 

19.	 If it is definitely a panic attack you can: Reassure the 
student that it is a panic attack, ask them how you 
can help, remain calm, speak in a reassuring manner, 
speak slowly and clearly, use short sentences, let 
them know it will pass, and avoid expressing negative 
thoughts. 

20.	NDSU’s Counseling Center does not work with 
complex trauma, eating disorders, or substance use. 
However, they make referrals to an outside agencies. 



21.	Raising a student’s distress tolerance is important 
so they are not seeking unhelpful ways of numbing 
their feelings which could include use of social media. 
Counselors want to see more normalization of mental 
health and the use of mental health professionals. 
This protects against a student’s inclination to use 
social media for self-diagnosis and get an accurate 
diagnosis from a mental health professional. 

22.	It is important for students to see that instructors are 
participating in conversations around student mental 
health.  

23.	Know that mental health reels and stories on social 
media are not vetted so the information included may 
or may not be accurate. Do not rely on social media for 
a diagnosis. Remind your students of this as needed.  

24.	Remind your students to think about their own 
physical wellness because that goes a long way toward 
alleviating mental health symptoms. Encourage 
students to eat right, get exercise, get enough sleep, 
lower their screen time, take time to meditate or even 
just sit in silence.  

25.	Too much screen time can mimick ADHD symptoms 
because you are training your brain to switch tasks 
every 30 or 40 seconds. Suggest students limit their 
screen time.

26.	Encourage students to shut off all digital or blue-light 
devices at least a half hour before bedtime to get 
better rest. 

27.	 Suggest that students have good sleep patterns, go to 
bed as close to the same time and get up as close to 
the same time as possible.

28.	As an instructor, learn the art of dialogue and become 
comfortable with having conversations about mental 
health. 

29.	Know there are cultures that do not recognize mental 
health. 

30.	Also note, if a student is crying in front of you it may 
not be a mental health issue, it could be something 
else like a fear of speaking with individuals in power. 
Do not be overly quick to walk the student over to the 
counseling center. 

31.	 Encourage your students to have more authentic and 
assertive conversations with their friends and family. 
For example, if they do not feel like going out with 
their friends they should be authentic and tell their 
friends. Or, if they feel someone is upset with them 
ask if their perception is correct. 

32.	There are services available for veterans on most 
college campuses, but for more extensive trauma 
they will be referred to another entity for assistance. 

33.	Only NDSU students are served by the counseling 
center. For family members there are some community-
based counseling centers that NDSU could refer them 
to. Some community-based counseling centers offer  
a sliding fee scale if cost is an issue. 

34.	Consider taking NDSU’s mental health first aid course 
to help you learn more about assisting your students 
with their mental health.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl
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